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Android 4 OS

Android 4 OS User Manual

(@ Chipsee

This manual is used to provide users with a fast guide of Chipsee Industrial Computers
(Abbreviated as IPC) about Android 4 OS development. Through this manual, users can
quickly understand the hardware resources; users can build a complete compilation of
Android development environment; users can debug Android 4 OS via serial, USB OTG and

Internet.
Revision Date Author Description
V1.0 2021-12-30 Randy Initial Version

SUPPORTED BOARDS:

CST0600F070 CST2800F101 CS14900F190 CS19108F215

PREBUILT FILES PACKAGE:

Prebuilt files for the various industrial PCs can be found in the OS Downloads.

Below are the links to the prebuilt files for each industrial PC model.

+ CS10600F070
+ CS12800F101
+ CS14900F190
+ CS19108F215

System Features

Chipsee

IPC
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Preparation

You will need to prepare the following items before you can start using the Prebuilt Files
Package to re-flash the system.

Power Supply Unit (PSU) with the appropriate voltages, as follows:

* These products: CS14900F190 and CS19108F215 requires a 15V to 36V power adapter.
* The CS10600F070 product needs a 6V to 36V power adapter.
* The CS12800F101 product needs a 12V to 36V power adapter.

Hardware Requirements

* Chipsee Industrial PC

+ PSU according to the instructions above

* USB-to-serial or other serial cable for debugging

* USB A-A cable (used only if the hardware configured as OTG)
* Windows 7 PC

Software Requirements

* Android 4 OS Prebuilt Files Package (from the link above)
* ADT for Windows

* Android USB driver (for Windows)

* MFGTools
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Getting Started and Tests

2 Note

Getting Started and Tests

Throughout this section, the user can use both the pre-built Android 4 image files and the MFGTools software to burn

files to the system, boot system and perform necessary software and hardware test.

Boot Switch Configuration

CS-IMX6 has a boot configuration select switch, as shown on the figure below. You can use
the boot select switch to change between two modes, namely

* eMMC Boot

* Download
SW Mode 3 4
eMMC 0 1
Download 1 0

Table 41 Boot Configuration Selection

Prepare Manufacturing Tool and Image

The manufacturing tool, referred to as MFGTool, is a tool that runs on a Windows PC. You
can use it to download pre-built images to the eMMC on a Chipsee board. The tools

directory contains the tar.gz file.

Windows download tool

Kernel Image

Boot.img

U-boot Image

u-boot.bin

Recovery Image

Recovery.img

Android File System

System.img

Chipsee

IPC
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Downloading Images by using MFGTool

MFGTool Windows download tool
Industrial Computer One
USB OTG Cable One
12V-2A power adapter One

Downloading Images by

using MFGTool

Chipsee IPC supports booting from an integrated eMMC.

Configuring MFGTool

To configure MFGTools, follow these steps:

* Unzip Mfgtools-Rel-xxx xxxxxx MX6Q UPDATER Vxx.tar.gz file.

* Open the extracted folder Mfgtools-Rel-xxx xxxxxx MX6Q UPDATER Vxx and edit
cfg.ini file.

| .. « Android » Tools » Mfgtools-Rel-1.1.0 121218 MX6Q_UPDATER V2.0 »

.—r

v WH Se;lrch Mfg.. P I
L 2 2

Figure 130: Extracted folder content

Organize v Include in library v Share with » Burn New folder 8= » [l @
A Favorites Name < Date modified Type Size
B Desktop .. Document 2016/5/3010:23 File folder
] Recent Places . Profiles 2016/5/30 10:23 File folder
& Downloads 1 Utils 2016/5/30 10:23 File folder
| cfg.ini 2016/5/27 9:42 Configuration sett... 1KB
4 Libraries i:*_) InternalParam.ini 2016/5/30 9:49 Configuration sett... 1KB
Esj Documents | MfgTool.log 2016/5/30 9:50 Text Document 14 KB
@' Music i MfgTool2.exe 2012/12/18 20:39 Application 1,661 KB
|| Pictures %) MfgToolLib.dll 2012/12/18 20:39 Application extens... 600 KB
¥ Videos £ | UICfg.ini 2013/9/18 11:33 Configuration sett... 1KB

*Inthe cfg.ini file, ensure the name variable is set to Android-SabreSD-eMMC , as
shown on the figure below.

Chipsee

IPC
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B S G

File Edit Format View Help

lprofiles] A
chip = M¥X6Q Linux Update

[platform]
board = SabreSD

[LIST
name SabreSD-eMNC '

|

|
L

Figure 131: Cfg.ini file
Copy Image To Android Directory
Follow these steps to copy image to Android directory:

* Unzip prebuilt-csXXXXXfXXX-vX-android-YYYYMMDD. rar file. The extracted folder will
contain these files: boot.img , recovery.img , system.img ,and u-boot.bin .

* Copy the files in the extracted folder to Mfgtools-Rel-
XXX XXX MX6Q_UPDATER_VXX\Profiles\MX6Q Linux Update\OS Firmware\files\android
directory.
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Downloading Images by using MFGTool

: _ o .
()% | « Profiles » MX6Q LinuxUpdate » OSFirmware » files » android » -

@
Organize v Include in library » Share with » Burn New folder i @
9 Eavorites 2 Name Date modified Type Size
— Desktop || bootimg 2016/6/26 23:40 IMG File 4852K
alli Recent Places || recovery.img 2016/6/26 23:40 IMG File 5,392 K
% Downloads || system.img 2016/6/26 23:41 IMG File 286,720 K
|| u-boot.bin 2016/6/13 23:22 BIN File 449 KB
4 Libraries
@ Documents
@' Music '
[=| Pictures
# Videos
Figure 132: Extracted folder with files
Using MFGTool

1. Connect a USB OTG cable from a Windows PC to the USB OTG port on the IPC.

2. Change the boot select configuration to 0 1 1 0, as shown on the figure below.

Figure 133: Boot Switch Config

3. Connect a 12V-2A power adapter to the IPC and power ON.

4. On your Windows PC, open the Mfgtools-Rel-XXX XXXXXX MX6Q UPDATER VXX
directory and run the MfgTool2.exe file, as shown on the figure below.

Chipsee

IPC
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Chipsee

Downloading Images by using MFGTool

Organize ¥ Include in library v Share with v Burn New folder
X Favorites Name . Date modified Type Size
Bl Desktop |, Document 2016/5/3010:23 File folder
2l Recent Places | Profiles 2016/5/3010:23 File folder
i Downloads L. Utils 2016/5/30 10:23 File folder
| cfg.ini 2016/5/27 9:42 Configuration sett... 1KB
(=4 Libraries 4 | InternalParam.ini 2016/5/30 9:49 Configuration sett... 1KB
@ Documents ' 2016/5/30 9:50 Text Document 14 KB
J’ Music ¢ MfgTool2.exe 2012/12/18 20:39 Application 1,661 KB
[&=] Pictures %, MfgToolLib.dll 2012/12/18 20:39 Application extens... 600 KB
B videos -| 4 UlCfg.ini 2013/9/18 11:33 Configuration sett... 1KB
& Homegroup
1% Computer
&, Local Disk (C:)
e Removable Disk (D:)
e Removable Disk (I:)
- < m | »

l 9 items

State: 2B Shared

Figure 134: Run MfgTools2.exe file

m MfgTool_MultiPanel (Library: 2.0.8)

Hub 5-Port 1
Drive(s):

HID-compliant device

- TheDevceIsReady

|

|

Status Information
Successful Operations:

Failed Operations:
Failure Rate:

Start

0%

2 Note

Figure 135: Prepare to start

If you get a message saying No Device Connected, check the USB-OTG cable to ensure it is ready.

i MfgTool_Multi

Hub 5-Port 1
Drive(s):

No Device Connected

IE§ E%ﬁf fg g?f %ﬁady

Status Information
Successful Operations:
Failed Operations:
Failure Rate:

Start

Exit

IPC
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Figure 136: The USB-OTG cable is not connected correctly.

5. Click on Start button to download the Image.

m MfgTool_MultiPanel (Library: 2.0.8) -
Hub 5-Port 3 Status Information

Drive(s): Successful Operations: 0

| = I Failed Operations: 0
soaCpemes Failure Rate: 0%
— :
e | Siop it

m MfgTool_MultiPanel (Library: 2.0.8) = e .
Hub 5-Port 3 Status Information

Drive(s): I: Successful Operations: 0

— — Failed Operations: 0

ol Kl el Failure Rate: 0%
LI Stop Exit

-

Figure 137: Loading Kernel and Formatting rootfs partition

2’ Note

If you are using a Window 7 PC, you will receive a prompt that asks you to format the disk. Please ignore or

cancel it.
Microsoft Windows . g

You need to format the disk in drive I: before
you can use it.

Do you want to format it?

[ Format disk ‘[ Cancel ]
N

6. When the process is complete, you click the Stop button to stop downloading
Image and exit.
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m MfgTool_MultiPanel (Library: 2.0.8) =Sl L
Hub 5-Port 1 Status Information
Drive(s): It Successful Operations: 1
v Failed Operations: 0
I Failure Rate: 0.00 %
| Stop =
]

Figure 138: Download Image is finished
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Booting Android OS And Test(Using 7inch as example)

The first time you start Android 4 OS on the industrial PC will take a little time. But after the
first time, Android 4 OS will start quickly. It is a successful start if you see the Android 4 OS

desktop such as the one shown in the figure below:

Camera

Figure 139: Android Desktop Screen
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SD Test

The IPC supports SD card hot-plug. The figure below shows the message when you plug the
SD card into IPC, but the IPC will not mount the SD Card.

root@sabresd_o6dq:/ #

root@sabresd_6dq:/ # mmcl: new high speed SDHC card at address 59b4
mmcbTkl: mmcl:59b4 SS08G 7.40 GiB

mmcbTkl: pl p2

Figure 140: Serial Message

You can mount the plugged SD card by using the following command.

# mount -t vfat /dev/block/mmcblklpl /mnt/extsd/

root@sabresd_6dq:/ # mount -t vfat /dev/block/mmcblklpl /mnt/extsd/
root@sabresd_6dq:/ # 1s /mnt/extsd/

MLO

boot.scr

u-boot. img

uImage

ubi.img

root@sabresd_6dq:/ #
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USB Flash Disk Test

The USB Flash Disk is like the SD Card, except for the mount point. The IPC mounts the USB
Flash Disk to /mnt/udisk .

root@sabresd_6dq:/ # ehci_fs1_bus_resume begins, Host 1
ehci_fs1_bus_resume ends, Host 1

usb 2-1.1: new high speed USB device number 3 using fsl-ehci
scsi0 : usb-storage 2-1.1:1.0

scsi 0:0:0:0: Direct-Access EAGET F30 1.00 PQ: O ANSI: ©

sd 0:0:0:0: [sda] 30326784 512-byte Togical blocks: (15.5 GB/14.4 GiB)

sd 0:0:0:0: [sda] write Protect is off

sd 0:0:0:0: [sda] Mode sense: 23 00 00 00

sddO:O:g:O: [sda] write cache: disabled, read cache: disabled, doesn't support DPO or FUA
sda: sdal

id 0:0:0:0: [sda] Attached sCSI removable disk

Fast Access

Device

Download

android 4.3 jb for imx6q java LOST.DIR mst

extsd

plooking pro System Volume android_language.txt
; Information
udisk
Library C =
android4.3_transplantati Example12_5client.java Example12_5server.java ft5x0x_driver.zip
Network on.txt
Tools -

1 5 » = [

Exit Recomme.. Theme Refresh i Windows

!

Figure 141: USB flash disk test
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SATA Test

Booting Android OS And Test(Using 7inch as example)

The SATA does not support hot-plug, but the Android 4 OS supports NTFS. You can use the
NTFS-3g tool to mount SATA disk partitions by running this command:

# ntfs-3g /dev/block/sdal /mnt/shm/

root@sabresd_6dq:/ # ntfs-3g /dev/block/sdal /mnt/shm

root@sabresd_6dq:/ # 1s /mnt/shm/

360SANDBOX

360fEZE€IZEEIC AUTOEXEC. BAT

CONFIG.5YS

Documents and Settings

I0.5YS
Installcl12
Intel

MSDOS. SYS
MsoCache
MaxReport
NTDETECT.COM
Program Files
RECYCLER

System volume Information

WINDOWS
bar.emf
boot. ini
bootfont.bin
dell
iNodeLog
ntldr
pagefile.sys

testbookmarks. html

tmp

root@sabresd_6dq:/ #

Fast Access

Device

Download

Library
Network

Tools

1 5 9

Exit Recomme.. Theme Settings

Chipsee

secure

IPC

shell

udisk

i

Windows
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Fast Access = s,

360SANDBOX 360/@E F &k dell Documents and Settings
Device
Download
iNodeLog InstallC112 Intel MaxReport
Library
MSOCache Program Files RECYCLER System Volume
Network Information

/. I Q ]

Theme  Settings Refresh i Windows

(—

Figure 142: SATA test
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Network Test

The network uses DHCP to get IP Addresses. You can get network access if you connect a
LAN cable from the IPC to a router.
You can change the IP Address with this command.

# netcfg eth® dhcp

Chipsee Homepage

© http://www.chipsee.com/ w Q

AR e «
Chipsee I 0070 /S 5 Engen
Eservice@cripsse.com My Account LogIn SignUp

HOME EMBEDDED COMPUTER EVALUTION BOARD SYSTEM-ON-MODULE ABOUTUS CONTACT US

see Embedded Computer
Size:5"/ 7°/ 8°/ 9.7"/ 10.4"

Capacitive/Resistive Touch

CPU: AM3354,1GHZ

DDR3/Nand Flash/eMMC

LAN/CAN/RS232/RS485

GPIO/USB/Wifi/BT/3G

d/linux/Debian/Angstrom/WinCE

New Arrivals

J
D
I

Chipsee IPC Page 19 of 51



Android 4 OS on iIMX6Q User Manual Booting Android OS And Test(Using 7inch as example)

Sound Card Test

Please open an audio file to test the Sound Card.

[} Jack Johnson

oY In Between Dreams

e

!! Better Together

Chipsee IPC Page 20 of 51
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Android 4 OS on iMX6Q User Manual

Video Test

Please open a video file to test the Video.

' Movies
(¢ Grid view

LLOWING PREVIEW HAS BEEN APPROVE

APPROPRI@AUDIENCES

MOTION PICTURE

atings.com

IATION OF AMERI

HDMI Test

You can reference this document, IMX6Q U-boot Setting HDMI Output For Android.pdf, to

learn about performing HDMI tests.

Chipsee
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2/’ Note

HDMI does not support hot-plug. The sound comes from the HDMI monitor, neither the speaker nor the headset on
board.

WIFI Test

You must ensure the IPC has an SDIO Wi-Fi module integrated before performing the Wi-Fi
test. If the IPC has an SDIO Wi-Fi Module, you can connect to the Wi-Fi and open a browser
to test.

Chipsee IPC Page 22 of 51
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ADB Test

You must enable USB debugging on IPC before performing ADB test.|br| Follow these steps
to enable USB debugging.

+ Goto the Settings and tap on About tablet tab, as shown on the figure below.

\/

on
= _| Settings

PERSUNAL

@® Location access
& Security

B Language & input
4 Backup & reset

ACCOUNTS

-+ Add account

SYSTEM

@®© Date&time
Wxccessibility

-

@ About tablet

* Tap on the Build number repeatedly until you enable Developer Options, as
shown on the figure below.

o6 [aa
(/=" | About tablet

Status

Status of the battery, network, and other information

Legal information

Model number
SABRESD-MX6DQ

Android version
4.3

Baseband version
Unknown

Kernel version

3.0.35
root@chipsesashuild. #1223

1 i 3
Theriiay 12 19:22:08 CST 2016 You are now 1 step away from being a developer

Build number
1.1.0-rc4

Figure 143: Enable Developer Options
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\/
R

—

X Settings

& Security
B Language & input

4 Backup & reset

ACCOUNTS

-+ Add account

SYSTEM

®© Date&time
W Accessibility
{ } Developer options

@ About tablet

Figure 144: Developer Options

* Move back to Settings and tap on Developer Options. You can enable USB
debugging by ticking the checkbox next to it.

S

& Security
B Language & input

£ Backup & reset

ACCOUNTS

-+ Add account

SYSTEM

®© Date&time
W Accessibilitv
{} Developer options

@ About tablet

Figure 145: Open USB Debugging

Also, you can use the ADB tool in the tools directory to test the ADB.

* Unzip it to the root directory of your Windows PC (Drive C), as shown on the figure

below.

Chipsee Page 24 of 51
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® ——-— - |
hll— N

.. » Computer » Local Disk (C:) » adb

= e — -
Include in library « Share with ¥ Burn New folde

“  Name .

£s

iop 27 adb.exe

nt Places % AdbWinApi.dll

loads %] AdbWinUsbApi.dll

i

ments

Figure 146: Unzip adb.rar to c:\

* You need to add path of the ADB directory to system’s environment variable.
Follow the steps described in the figures below to set the environment variable.

1® » Control Panel » System and Security » §

Control Panel H ) ..
o e View basic inforn
# Device Manager Windows edition
%' Remote settings Windows 7 Ultimat
= e % System protection Copyright © 2009 |
n fve... -
ap etwo € % Advan m settin Service Pack 1
Disconnect network drive...
Create shortcut
Delete
——r System
r Rating:
Properties Processor:

Figure 147: Open Advance system settings
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—_— -
System Properties é Environment Variables T— - ﬁ
Advanced
Computer Name I Hardware v System Protection I Hemotel Uiser variables for admin
You must be logged on as an Adminstrator to make most of these changes. ( Variable value
Performance TEMP Y%USERPROFILE % \AppData \Local\Temp
Visua effects, processor schedulng, memory usage. and virtual memory T™P YISERPROFILE % \AppData\Local \Temp
User Profiles New... ] [ Edit... ] [ Delete ]
Deskiop settings related to your logon
System variables
l Sgttings... Variable Value =
NUMBER_OF P... 4
Startup and Recovery os Windows NT
System startup, system failure, and debugging information C:\Program Files\Java'jdk1.8.0_91'bin;... me
“COMT. T.ORT;.CVD;. VB, . VoL, . JS;
Settings o
New... S Edit... D Delete
‘ Environment Variables...
o< J[ conce |
l  —
| oK || camesl || &

Booting Android OS And Test(Using 7inch as example)

Figure 148: Open and edit the **Path* system variable*

7

S

Edit System Variable
Variable name: Path
P N
Variable value: \bi@ \Program Files (x86)\Skype\P

’ OK ‘ ’ Cancel ‘

A

A

Figure 149: Add path of the ADB directory to the Path system variable

* Open the command-prompt on Windows and enter this command adb version , as
shown on the figure below. The process is successful, if the command-prompt

displays the version number of ADB.

C:\UsersNadmin>adbh version
Android Debug Bridge version 1.60.31

C:\UsersNadmin>

Figure 150: ADB tool is working

* Connect the USB-OTG cable from the Windows PC to IPC. You will get a message
Allow USB debugging?. Please select Always allow from this computer and click

Ok.

Chipsee IPC
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Allow USB debugging?

The computer's RSA key fingerprint is:
B6:1E:7A:27:A5:35:47:55:50:F8:F5:CF:F0:81:C2:E9

v Always allow from this computer

Cancel

Figure 151: Enable USB debugging

You can list the devices attached to the Windows PC with this command.

$ adb devices

C:\UsersN\admin>adbh devices
List of devices attached
1123456 789ABCDEF device

Figure 152: Checking devices attached

You can install an android app from the Windows PC onto the IPC with this command.

$ adb install XXX.apk

C:\UsersNadmin>adbh install E:“share\APK\com.rovio.angryhirds—1.apk
1305 KB/s (29008466 bhytes in 21.685s)

prkg: sdataslocal/tmp/com.rovio.angryhirds—1.apk
Success

C:\UsersN\admin>
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WIDGETS

u

Angry Birds Browser

D B

Downloads Email

>“‘<
TIFF
o3 0828

Movie Studio MultiTouch Test..

Serial Port Settings

Chipsee

Cactus Player
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Touch Screen Test

Run MultiTouch Tester App.
The screen will show the number and position of the touch point when touching the screen.

2 Note

* Resistive screen expansion board only supports single-touch, and capacitive screen expansion board supports
five-point touch as described in the figure below.

* The 21.5", 19", and 17" capacitive screen supports a ten-point touch.

Figure 154: Touch screen test (Capacitive touch)
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Serial Test

There are five serial ports on the Chipsee IPC: 2 x RS232 and 3 x RS485 (can be customised).
Refer to the table below for the available serial device nodes.

Ports Device Node
COM1(RS232, Debug) /dev/ttymxcO
COM2(RS485) /dev/ttymxc
COM3(RS232) /dev/ttymxc2
COM4(RS485) /dev/ttymxc3
COMS5(RS485) /dev/ttymxc4

Table 42 Serial Ports Nodes on the System

2 Note

If you use COM2(RS485), you can't use Bluetooth because COM2(RS485) share pin with Bluetooth.
You can install the SecureCRT or Putty software on a Windows 7 PC to test the serial ports
by following these steps:

* Connect COM1 on industrial PC board to Windows 7 PC.

* Run Serial Port APl App to communicate with Windows 7 PC, as shown on the
figure below.

¢ Serial Port
5

Setup
Console
Loopback
About

Quit
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Device

ttyGS3 (g_serial)
ttyGS2 (g_serial)
ttyGS1 (g_serial)
ttyGSO (g_serial)
ttymxc3 (IMX-uart)

ttymxc2 (IMX-uart)

ttymxc1 (IMX-uart)

ttymxcO (IMX-uart)

Figure 155: Serial settings

* Push the button with the label “Send 01010101”, you will see something on the
Windows 7 PC that looks similar to the figure below.

Serial-COM33 - SscurccRL A = 1 |
MR #EE BEV ERO Fam BEs IRL =EH)
HIPNEDE aBA LS XY 0 .

«” Serial-COM38 4 b

UuUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUUDUUDUULULY . |
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Figure 156: Serial send test

* Push the button with the label “Console”, to send whatever you like as shown on
the figure below.
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Y T2

Chipsee serial test!

Emission

Figure 157: Serial receive test
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GPIO

For the CS12800F101 IPC, there are 8 GPIO ports that you can set as output or input with
LOW as 0V; the HIGH as 3.3V.

Please check the GPIO Connector section in CS12800F101 to know the position of the GPIO
Connector. Refer to the table below for the available GPIO nodes on system.

PIN Number GPIO Number
3 gpio106
4 gpio30
6 gpio95
7 gpio87
8 gpio29
9 gpio28
11 gpio94
12 gpio130

Table 43 GPIO Nodes on the System

Example: We are going to set gpio106 as output, and let it output HIGH or output LOW.

# echo 106 > /sys/class/gpio/export //export gpiol06

# echo out > /sys/class/gpio/gpiol@6/direction //set gpiol06 output

# echo 1 > /sys/class/gpio/gpiol06/value //set gpiol06 output HIGH
# echo 0 > /sys/class/gpio/gpiol06/value //set gpiol06 output LOW

Example: We are going to set gpio30 as input.

# echo 30 > /sys/class/gpio/export //export gpio30
# echo in > /sys/class/gpio/gpio30/direction // set gpio30 input

Example: We are going to set gpio30 as unexport.

# echo 30 > /sys/class/gpio/unexport //unexport gpio30
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Android 4 system debug in Windows

Android 4 system debug in Windows

In this section, we will discover how to view the Android 4 system via the serial port and
debug the system via USB OTG.
Also, we will discover how to install and uninstall applications via USB OTG.
The following operation is under the Windows 7 x64 environment, similar to other Windows

platforms.

View Android 4 system via the serial port

Install the SecureCRT or Putty software on a Windows 7 PC to view the Android 4 system

via the serial ports.

Follow these steps to view Android 4 system via the serial port:

* Connect COM1 on the industrial PC board to Windows 7 PC.

* Open the SecureCRT or Putty software on the Windows 7 PC and configure it as

shown on the figure below.

Session Options - R$232-Left(COM4) (S|
Category
- Connection Serial Options
i i.Logon Seripts
L Port: COM4 v  Flow Contrel
E-Terminal Beud rate: (115200 - | |JDTR/ISR
[=)-Emulation D RTS/CTS
| Enacs e s | XON/XOFF
i Advanced o
[=]- Appearance Stopibits:
e findow
~Log File Serial bresk 100 % milliseconds
[=-Printing
i Advanced
. Xmodem/Zmodem
| 0k || Cancel

Figure 158: SecureCRT configuration

* Power ON the industrial PC. You will see the serial output information as shown

Chipsee

on the figure below.
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Hit_any key to stop autoboot: O
mmc3(part 0) 1is current device

MMC read: dev # 3, block # 2048, count 12288 ... 12288 blocks read: oK
## Booting kernel from Legacy Image at 10800000 ...

Image Name: Linux-3.0.35-2508-g54750ff

Image Type: ARM Linux Kernel Image (uncompressed)

Data Size: 4805952 Bytes = 4.6 MB

Load Address: 10008000

Entr¥ Point: 10008000

verifying Checksum ... oK

Loading Kernel Image ... OK
OK

starting kernel

uncompressing Linux... done, booting the kernel.

Linux version 3.0.35-2508-g54750ff %root@chipsee-bui]d) (gcc version 4.6.2 20110630 (prerelease) (Freesc
CPU: ARMV7 Processor [412fc09a] revision 10 (ARMV7), cr=10c53c7d

CPU: VIPT nonaliasing data cache, VIPT aliasing instruction cache

Machine: Freescale i.MX 6Quad/pDualLite/solo Sabre-sb Board

Ignoring unrecognised ta? 0x54410008

Memory policy: ECC disabled, Data cache writealloc

CPU identified as i.MX6Q, unknown revision

PERCPU: Embedded 7 pages/cpu @8c80e000 55440 r8192 d15040 u32768

Built 1 zonelists in Zone order, mobility grouping on. Total pages: 462848

Kernel command line: console=ttySAC0,115200 video=mxcfbO:dev=1db,LDB-WXGA,if=RGB24,bpp=32 1db=sin0 videc
kernel time=10:10:07,date=Jun 23 2016

PID hash table entries: 4096 (order: 2, 16384 bytes)

Dentry cache hash table entries: 262144 (order: 8, 1048576 bytes)

Inode-cache hash table entries: 131072 (order: 7, 524288 bytes)

Memory: 1568MB 256MB = 1824MB total

Memory: 1836188k/1836188k available, 260964k reserved, 262144K highmem

virtual kernel memory layout:

vector : Oxffff0000 - Oxffff1000 ( 4 k)
fixmap : O0xfff00000 - Oxfffe0000 ( 896 kB)
DMA : 0xf4600000 - Oxffe00000 ( 184 mB)
vmalloc : 0xea800000 - 0xf2000000 ( 120 mB)
Towmem : 0x80000000 - Oxea000000 (1696 MB)
pkmaq : 0x7fe00000 - 0x80000000 ( 2 MB)
modules : 0x7f000000 - Ox7fe00000 ( 14 mB)

.init : 0x80008000 - 0x8003d000 ( 212 kB)

.text : 0x8003d000 0x80c44bf0 (12319 kB)
.data : 0x80c46000 0x80ccchel ( 539 kB)
.bss : 0x80cccc04 0x80d252ec ( 354 kB)

SLUB: Genslabs=13, Hwalign=32, order=0-3, MinObjects=0, CPUs=4, Nodes=1

braamntihla hiararchicral ol imnlamantatinn

Figure 159: Serial output information

* You can communicate with the system when system boot is complete.

Chipsee
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Adb connect via USB OTG

Please refer to the ADB Test chapter to learn how to set the ADB, how to install an app via
ADB, and how to debug with ADB.
You can use the following command to log in to the board and communicate with it.

> adb shell

C:\Users\Chipsee>adb shell
shell@sabresd_6dg:/ $§ su
su

root@sabresd_6dg:/ # 1s

fstabh.freescale

init

init.chipsee.sh
init.environ.rc
init.freescale.i.ME6DL.rc
init.freescale.i.MZ6Q.rc
init.freescale.i.ME6QP.rc
init.freescale.rc
init.freescale.ush.rc
init.rc
init.recovery.imxb.rc
init.trace.rc
init.ush.configfs.rc
init.ush.rc
init.zygote32.»rc

Figure 160: ADB Shell
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Use ADB command to install user APP

Use the adb command to install an Android App: for example Sogoulnput.apk. If there is a
SUCCESS message, as shown on the figure below, then the app installation was successful.

> adb install Sogoulnput.apk

C:\Windows\system32\cmd.exe | ==l Ii&-J

G:\AndroidNadt—bhundle—windows—x86_64-201308217\sdk\platform—tools>adbh install Sogls

2972 KB/s (11137726 hytes in 3.659%9s>
rkg: sdataslocal/tmp/Sogoulnput.apk
Success

G: \Android\adt—bundle-windows—x86_64-20138%17\sdk\platform—tools>

Figure 161: Install App
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Use ADB command to uninstall user APP

Adb connect via USB OTG

Use adb command to uninstall an Android app: for example AngryBirds.apk. Follow these

commands to uninstall an app.

> adb shell pm list packages
> adb uninstall com.rovio.angrybirds

* The pmlist command gets the full name of the app, as shown on the figure below.

C:\UsersNadmin>adb shell pm list packages
package:com.freescale.uwfdsink

package :com.android.soundrecorder

package :com.android.launcher
package:com.android.defcontainer

patkage :com.rovio.angryhirds

package fCoOM. AMAPFUId-quicksearchhox
package:com.theS511iplus.MultiTouchTester
package :com.android.contacts

package :com.android.inputmethod.latin
package :com.android.phone

Figure 162: Uninstall user app

* The uninstall command uninstalls the app from the Android system.

* Delete the apk file for the app by using these commands:

> adb shell
# cd /system/app/
# 1s

# rm Browser.apk

Chipsee IPC
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Use ADB command to uninstall default APP

Adb connect via USB OTG

Use adb command to uninstall an Android app: for example Email.apk. Follow these
commands to uninstall a default app.

> adb shell

$ su
su

# cd /system/app

cd /system/app

# rm Email.apk

Chipsee

C:\UsersN\admin>adb shell
shell@sabresd_b6dg:/ § su

su

root@sabresd_bdg:/ # cd /system/app

cd /system/app
root@sabresd_bdg:/system/app # rm Email.apk_

Figure 163: Uninstall default app

IPC
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Use ADB command to uninstall default APP

Use adb command to transport files between the industrial PC and Windows 7 PC.

* Transfer file from the industrial PC to Windows 7 PC using adb pul/ command.

> adb pull <pathTo file on board> <pathTo store file on PC>

* Transfer file from the Windows 7 PC to the industrial PC using adb push
command.

> adb push <pathTo file on PC> <pathTo store file on board>

For example, copy <ADT>\sdk\platform-tools\chipsee.txt from Windows PC to IPC:

> adb push chipsee.txt /chipsee.txt

Copy /testFile.txt from IPC to Windows PC:

> adb pull /testFile.txt testFile.txt
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Adb connect via internet

1. The Ethernet port on the industrial PC and the host machine (Windows 7 PC)
should connect to the network. Check Ethernet configuration for the industrial PC
using the command below.

# netcfg

lo uP 127.0.0.1/8 0x00000049 00:00:00:00:00:00
cano DOWN 0.0.0.0/0 Ox00000080 00:00:00:00:00:00

eth@ uP 192.168.6.176/24 0x00001043 le:ed:19:27:1a:b3

2. If the industrial PC's Ethernet is not configured, configure the Ethernet using the
ifconfig / netcfg command as shown below.

# netcfg eth@ dhcp

3. Configure the ADB Daemon to use an Ethernet connection using the setprop
command, as shown below.

# setprop service.adb.tcp.port 5555

4. If the network is configured successfully using the steps above, then Restart
service adbd on the Windows 7 PC.

# stop adbd
# start adbd

5. On the host machine (Windows 7 PC) use the following commands to establish the
adb connection.

$ adb kill-server
$ adb start-server
$ adb connect :5555

6. Verify the device connectivity, by executing the following commands. If
connected, find the device name listed as  IPADDRESS:PORT .

$ adb devices
List of devices attached
192.168.6.176:5555 device
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7. An example of using the adb command to install software for Android. Make sure
the "**x"_ apk file is at the current folder, and export the adb path.

+ Use the argument —s to assign the device to use over the internet.

$ adb —s 192.168.1.117:5555 install "**".apk
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Android App Development

Android App Development

In this section, we will introduce the development of an Android app with Eclipse on
Windows. We assume that the USB is OTG model and the driver is already installed. (See

Adb connect via USB OTG)

Preparation

1. Download and install Eclipse IDE.

2. Go to the /eclipse folder, start eclipse.exe.

© Java - ADT B R T T = e =
File Edit Source Refactor Navigate Search Project Run Window Help
T~ BB NI O Q@ @ v S O e |
Quick Access ot |@ DDMS
[£ Package Explorer 5% = 0 = 0 o= Outline 52 = 0
Bg ¥ An outline is not available.
|
(|
|
(|
||
(|
||
||
||
L Problems @ Javadoc [&, Declaration '[E] Console $2 ¥ LogCat EN EE| #E~rivy= 08
|| Android
[2016-@5-31 17:46:38 - SDK Manager] [SDK Manager] S&sfissssimsa. -
|| [2016-05-31 17:46:30@ - SDK Manager] [SDK Manager] S&#TIszEsme.
[2016-05-31 17:46:3@ - SDK Manager] [SDK Manager] S&E#TIszEsms.
| [2016-05-31 17:46:3@ - SDK Manager] [SDK Manager] sS&sFIszsss. 3
< T ] )
|| T .
L | soMof262m [

Figure 164: Start eclipse

3. Click Windows->Android SDK Manager to open SDK Manager.
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Preparation

-
@ Java - ADT

[o/@] =

i

File Edit Source Refactor

DR RGNS S O QU TG (SR ST B e

[£ Package Explorer 53

Navigate Search Project Run Window Help

v

v|

Quick Access

Android SDK Manager

(=] O

Packages Tools

SDK Path: C:\Users\admin\Desktop\adt-bundle-windows-x86_64\adt-bundle-windows-x86_64-20131030\sdk

4 Android SDK Build-tools
4 Android SDK Build-tools
" Android SDK Build-tools
4 Android SDK Build-tools 19
4 Android SDK Build-tools
4 Android SDK Build-tools

7 Installed

" Android SDK Build-tools 17
4 [F1F2 Android 4.4.2 (API 19)

Packages
' Name APl Rev. Status -
4[] Tools|
# Android SDK Tools 22.3 [ Update available: rev. 24.0.2 a
,f‘ Android SDK Platform-tools 20 7 Installed 1
,f' Android SDK Build-tools 19.1 [ | Not instslled

19.0.3 (| Not installed
19.0.2 [~ Not installed
19.01 | Not installed

18.1.1 ["| Not installed
181 [ | Not installed
" Android SDK Build-tools 18.0.1 [ Not installed
| Not installed

-

Show: Updates/New [V|Installed [ |Obsolete Select New or Updates

Sort by: @ API level © Repository Deselect All

Install 1 package...
Delete 1 package...

Done loading packages.

|0~zy

| & | @)@ oows

X = 8

is not available.

[2016-85-31 17:46:38 - SDK Manager] [SDK Manager] s&smzszsis.
[2016-05-31 17:46:3@ - SDK Manager] [SDK Manager] S&E#TIszsme.
[2016-85-31 17:46:38 - SDK Manager] [SDK Manager] S&s7szsis. @

< m ]

| 129M of 320M

m:

Figure 165: Android SDK Manager

4. Click Tools->Options, check the Force box and click close.

Chipsee
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Preparation

-
@ Java - ADT

[o/@] =

File Edit

o

[£ Package Explorer 53

Source Refactor

Navigate Search

Project Run

Window Help

TR B G ENIRS O Qv G (57

Quick Access

| o | @)@ oows

Use download cache

Enable Preview Tools

Sort by: © API level

Done loading packages.

stall 1 package...
Delete 1 package...

-
Android SDK Manager (=@ =
Packages Tools b Android SDK Manager - Settings u
SDK Path: C:\Users Proxy Settings 030\sdk
Packages HTTP Proxy Server |
T -~
pigiiame : HTTP Proxy Port =
] Tools
V! And [ . 24,0.2 -
; Andr Manifest Cache E £
F ndri
,/, And, Directory: C:\Users\admin\.android\cache
[ 4 Andh Current Size: 662 KiB

O

Iw

he &2

ne is

= 0

not available.

Fvnv=a

| [2016-85-31 17:46:30
[2016-05-31 17:46:30
[2016-05-31 17:46:30
[2016-05-31 17:46:30

SDK Manager] [SDK Manager] SSsTIsssme.
SDK Manager] [SDK Manager] S&aFisssime.
SDK Manager] [SDK Manager] S&#fassssms.
SDK Manager] [SDK Manager] SsaTIsssme.

<

n

J

{

129Mof 320M |}

1

Figure 166: Android SDK Manager Settings

5. Choose the API, such as Android4.3(API 18), then click the Install packages button

Chipsee
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to start the download and installation of APl packages.
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Preparation

-
@ Java - ADT 3

[o/@] =

File Edit Source Refactor Navigate Search Project Run Window Help

I ENENCE R B M NS - O Q) - @ 8 D e e G

v|

Quick Access

| & | @)@ oows

f& Package Explorer &3 Android SDK Manager

(=] O

X = 8

Packages Tools

Packages

SDK Path: C:\Users\admin\Desktop\adt-bundle-windows-x86_64\adt-bundle-windows-x86_64-20131030\sdk

is not available.

' Name APl Rev. Status
b [/ Tools|
Android 4.4.2 (API 19)
[2 Android 4.3 (API 18]
= Android 2.2 (API 17)
> [2 Android 4.1.2 (API 16)
> [2 Android 4.0.3 (API 15)
[2 Android 4.0 (API 14)
[ Android 3.2 (API 13)
[2 Android 3.1 (API 12)
[2 Android 3.0 (API 11)
[2 Android 2.3.3 (API 10)
> [F1E2 Android 2.2 (API 8)
> [F1F2 Android 2.1 (API 7)

-

Show: Updates/New [V|Installed [ |Obsolete Select New or Updates

Sort by: @ API level © Repository Deselect All

(| Install 4 packages...
Delete 2 packages...

l(’)f;

Done loading packages.

[2016-85-31 17:44:11 - SDK Manager] [SDK Manager] S&smzszsie.
[2016-05-31 17:44:11 - SDK Manager] [SDK Manager] S&E#TIszsms.
[2016-05-31 17:44:11 - SDK Manager] [SDK Manager] S&#TIszsne.

< m ]

| 119M|of 262M

m:

Figure 167: Install APl packages

6. Downloading and installing the packages will take some time. When the process

Chipsee

completes, close the Android SDK Manager.
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Example — Develop a HelloWorld Program

1. Click File->New->Android Application Project

(@ sava - aDT (=[@] = )
File Edit Source Refactor Navigate Search Project Run ﬂindow Help
T~ 3 N=RIGREREEREE SR A » B Al REaS:SRCA S RN Al SR S EReh Ssh d e
Quick Access E{|@ DDMS
f& Package Explorer &2 = V@ New Android Application Lilﬂlg]ine & = g
2%

— ine is not available.
New Android Application
/4 The prefix 'com.example.’ is meant as a placeholder and should not be used

Application Name:® HelloWold

Project Name:® HelloWold

Package Name:& com.example.hellowold

Minimum Required SDK:O[API 18: Android 4.3 VI
Target SDK:| API 18: Android 4.3 -

Compile With:0[API 18: Android 4.3 ]
Theme:O[Holo Light with Dark Action Bar VI

. Choose a target API to compile your code against, from your installed SDKs. This is typically the

most recent version, or the first version that supports all the APIs you want to directly access
without reflection.

r
PTE ~r5~= 08

| -

— Bty on device @1:

@ b oo
current task he |

|
< 1 ] )

| 136Mof26oM [
(.

Figure 168: New Application

2. Click on the Next button until the app project is created. Connect the industrial
PC to Windows 7 PC via the USB cable (A-A). If the connection is successful, you

will see the device in the DDMS window (Windows->Open Perspective->Other-
>DDMS)
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— -
) DDMS - HelloWorld/src/com/example/helloworld/MainActivity.java - ADT E‘E‘ﬂ
File Edit Source Refactor Navigate Search Project Run Window Help
g e : Ry A NE AT IR v v = v | ¥ Quick Access : Ej‘aj)ava
g Devices 2 = 08 %Threads 2@ @ ) = g8
Ksaslz2 0 G @
< no client is selected
Name
a ﬂ freescale-sabresd_mx6dq-0123456789AE
com.example.helloworld
|
< n »
& LogCat 2 = 8
Saved Filters & = B ccarch for messages. Accepts Java regexes. Prefix with pid:, app:, tag: or text: to limit scope.
All messages (no filter . L
L. Time PID TID Application Tag Text
[l com.example.hellowor
D 05-31 17: 3603 3603 com.example.hello... 1ibEGL loaded /system/lib/egl/libEGL_VIVA
D 05-31 17: 3603 3603 com.example.hello... 1ibEGL loaded /system/lib/egl/libGLESvl_C
D 05-31 17 3603 3603 com.example.hello... 1ibEGL loaded /system/lib/egl/libGLESv2_V
D 05-31 17 3603 3603 com.example.hello... OpenGLRenderer Enabling debug mode 0
< m < [ »
145Mof 320M |
—

Figure 169: DDMS

3. You can capture the desktop of Android

@ DDMS - HelloWorld/src/com/example/helloworld/MainActivity.java - ADT = |8 =

File Edit Source Refactor Navigate Search Project Run Window Help

S ¢ ; R R R R R e RS Quick Access | B | & eva [BoDMS] | bgmnE
- FI\EE[RE

% Threads 22 3 @ @ = 8

Devices §32 = 0

8

swelzeiq s @r
pi

4 r — — N
Device Screen Capture &

Name

+ @ freescle (Leheen ] [Lpoue ]

com.e{|| Captured image:

[, Google

Fruit Ninja

D LogCat &

Saved Filters

All messages

Chipsee IPC Page 48 of 51



Android 4 OS on iMX6Q User Manual

Example — Develop a HellowWorld Program

Figure 170: Capture Android Desktop

4. Click run, and choose the device

{}) Java - HelloW: c/com/example/helloworld/MainActivity.java - ADT = | B P
Edit Source Navigate Project Run Window Help
1ig & diINiIErQ Qi G i il Gl Cl =
Quick Access & pbms
[£ Package Explorer 5% = O [J] MainActivity.java &2 = 0 5% Outline 52
s
&) Android Device Chooser léj ¥ o w
|
== HelloWorld . . . le.hell
4 = HelloWor Select a device with min API level 18. pm.examp enetov
4 (3 src i K . MainActivity
© Choose a running Android device
4 f} com.example] © a onCreate(Bund
[5) MainActivi Serial Number AVD Name Target Debug State © . onCreateOptio
&8 gen [Generated Q freescale-sabresd_mx6dg-0.. N/A v 43 Online
=) Android 4.3
5 Android Private
: assets
&= bin
&= libs Launch a new Android Virtual Device
a
= res AVD Name Target Name Platform API Level CPU/ABI Det
A AndroidManifes § ilabl
availaple
57 ic_launcher-web,
|5 proguard-projeq
|2 project.propertig
U | »
[[]Use same device for future launches OK ] [ Cancel ] f v Y=
\
[2016-05-31 17:41:28 - HelloWorld] ------------------------------ A
[2@16-05-31 17:41:28 - HelloWorld] Android Launch!
[2016-05-31 17:41:28 - HelloWorld] adb is running normally.
[2016-05-31 17:41:28 - HelloWorld] Performing com.example.helloworld.MainActivity activity launch
< m »
Writable Smart Insert el 163M of 267M [ : Launching HelloWorld: (1009) pr—

Figure 171: Run HelloWorld Program

5. Result

oo B

-
I Helloworld

Hello world!
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Figure 172: HelloWorld Program

2/ Note

If the USB is not configured as an OTG model, you can copy and install the file HelloWorld.apk from the project
folder HelloWorld/bin/ , orinstall the HelloWorld.apk viathe internet (See Adb connect via internet).

For more resources about Android development, visit these links:

https://developer.android.com/guide/index.html https://developer.android.com/develop/
index.html http://developer.android.com/support.html http://blog.apptopia.com/android-
development-forums/ http://androidforums.com/application-development/
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Disclaimer

This document is provided strictly for informational purposes. Its contents are
subject to change without notice. Chipsee assumes no responsibility for any errors
that may occur in this document. Furthermore, Chipsee reserves the right to alter the
hardware, software, and/or specifications set forth herein at any time without prior
notice and undertakes no obligation to update the information contained in this
document.

While every effort has been made to ensure the accuracy of the information
contained herein, this document is not guaranteed to be error-free. Further, it does
not offer any warranties or conditions, whether expressed orally or implied in law,
including implied warranties and conditions of merchantability or fitness for a
particular purpose. We specifically disclaim any liability with respect to this
document, and no contractual obligations are formed either directly or indirectly by
this document.

Despite our best efforts to maintain the accuracy of the information in this
document, we assume no responsibility for errors or omissions, nor for damages
resulting from the use of the information herein. Please note that Chipsee products
are not authorized for use as critical components in life support devices or systems.

Technical Support

If you encounter any difficulties or have questions related to this document, we encourage
you to refer to our other documentation for potential solutions. If you cannot find the
solution you're looking for, feel free to contact us. Please email Chipsee Technical Support at
support@chipsee.com, providing all relevant information. We value your queries and
suggestions and are committed to providing you with the assistance you require.
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